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Chapter 1: Using asset classes 

1. Using asset classes 
When using the asset classes method for assigning return rates, you can establish up to 30 
asset classes with corresponding returns and an unlimited number of model portfolios. 
Returns for each asset class can be defined according to interest, dividends, capital gains 
(realized annually), deferred growth (unrealized until redemption), and tax free. All 
investment income is given the appropriate tax treatment based on these classifications. 

For our case study we will use the asset classes method as a means of calculating default 
return rates. 

Defining asset classes 

Procedure 
1. Go to the Edit menu, and then select Preferences. 

2. Go to the Asset Classes tab – Classes subtab. 

3. Select the Use asset class weightings for setting asset return rates check box. 

This check box specifies this method as the default method for calculating asset 
returns for all future plans. 

4. Click the New Asset Class button four times to create four blank rows. 

5. Enter the asset classes and their corresponding return rates, as listed below: 

 Interest Dividends Capital 
Gains 

Deferred 
Growth 

Tax 
Free 

Standard 
Deviation

Foreign 
Equity 0.00% 4.00% 0.00% 8.00% 0.00% 10.00% 

Domestic 
Equity 0.00% 2.00% 0.00% 8.00% 0.00% 8.00% 

Fixed 
Income 3.00% 2.00% 0.00% 2.00% 0.00% 4.00% 

Cash 3.00% 0.00% 0.00% 0.00% 0.00% 3.00% 
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Defining model portfolios 

Procedure 
1. Go to the Portfolios subtab. 

2. Click the New Portfolio button three times to create three blank rows. 

3. Enter the portfolios and corresponding asset class weightings, as follows: 

 

 Foreign 
Equity 

Domestic 
Equity 

Fixed 
Income Cash 

Aggressive 20.00% 60.00% 20.00% 0.00% 

Moderate 0.00% 40.00% 40.00% 20.00% 

Balanced 0.00% 30.00% 30.00% 40.00% 

4. From the Default Portfolio list, select Balanced. 

5. Click OK to save the new default asset classes and model portfolios. 
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Chapter 2: Case study instructions 

2. Case study instructions 
Now that we have established all of the necessary defaults, we can proceed with our analysis 
of the Geller case study. An initial meeting was conducted with the family, and as a result, 
financial goals and objectives were established. Also, all current financial information was 
documented using the Fact Finder available in NaviPlan. 

Case study process model 
 

 

Start 
planning 

 

Confirm the 
data entered 

 

Open the 
client file 

 

Review 
Family 

introduction 
and the Fact 

Finder 

Review Family introduction and the Fact Finder 
Review the chapter entitled Family introduction to get a sense of the clients’ financial 
objectives. Then, refer to the chapter entitled Fact Finder to become familiar with the 
Gellers’ current financial situation. 

Open the client file 
Go to the File menu, and then select Open – Client – Geller, Jack and Linda.npe to 
open the Geller client file. All of the clients’ current financial data has already been 
entered into the base plan for you. 

Confirm the data entered 
Use the Plan Analysis Synopsis report to confirm that the data entered is free from errors. 

Compare this report with the chapter entitled Fact Finder. 

Start planning 
Proceed to the chapter entitled Financial planning strategies and begin working through 
the exercises. 
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Chapter 3: Family introduction 

3. Family introduction 
The following case study provides an example of how you can use NaviPlan to help your 
clients meet their financial goals and objectives, both during their lifetime and at death. 

Personal information 
Jack and Linda Geller have requested your assistance in developing a financial plan to 
manage their wealth and better define their financial objectives. The clients have used the 
services of many financial service providers in the past to provide guidance in meeting 
specific goals. However, they are looking for a practitioner who offers a more holistic 
approach to financial planning. 

Client Age Health Relationship 

Jack 60 Excellent Husband 

Linda 58 Excellent Wife 

Employment 
Jack works for an advertising firm as a successful business executive. He is also 
interested in exploring his entrepreneurial side by taking advantage of some business 
opportunities that have been presented to him. Jack has experimented in small business 
and currently owns a small property-management firm. He is unsure if he should 
maintain the business, as it ties up capital that he could use for other ventures. Jack’s base 
salary as a business executive with the advertising firm is $800,000. Jack also has an 
existing SARSEP, to which he contributes $13,000 annually, and the company has been 
matching his contribution each year. The Gellers are rapidly approaching retirement, but 
Jack has thoughts of only a partial retirement. 

Linda is a public relations expert and loves her job. Linda’s base salary is $350,000. 
Linda’s company sponsors a 401(k) profit-sharing plan, which allows for pre-tax 
contributions and an employer match. 

Financial position 
Jack and Linda are completely debt free. However, they are not debt adverse and would 
borrow to fund the right business opportunity. They own their home with a market value 
of $3,000,000. Jack’s property management business is valued at $1,000,000. It generates 
$120,000 in income each year before expenses. The Gellers’ financial position also 
includes stock options, bonds, mutual funds, and some works of fine art. 

The family currently spends $33,000 per month on regular household expenses such as 
food, utilities, transportation, and other discretionary spending. Also, they are paying 
$2,000 per month in real estate and property taxes, which are 100% deductible. 
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Jack and Linda have set aside funds to help pay for their daughter’s wedding. Sarah, their 
daughter, and her fiancé are planning to wed in June 2006. The proceeds for the wedding 
are saved in a balanced-growth fund that has a current market value of $30,000. 

The Gellers also love to travel and they usually plan for a major trip every two years. 

Goals and objectives 

House downsize 
Jack and Linda have grown children who have completed college and are now living 
on their own. Since the children have left home, Jack and Linda are thinking of 
selling the family home and purchasing a condominium. This decision is fueled more 
by manageability than finances. 

Business opportunity 
Recently, a business associate approached Jack regarding collectively forming a 
corporation to house a business venture that has the potential to produce excellent 
revenue. Jack believes that this could be a lucrative opportunity that would satisfy his 
objective of entering into the entrepreneurial world. He is concerned about 
committing a large amount of capital to this venture because he and Linda are close to 
retiring from their primary careers and he feels that this capital should be left 
available for other things. 

Compensatory stock options 
Jack and Linda have both been granted options to purchase stock in their respective 
companies. Jack has been granted incentive stock options from the advertising firm 
that he works for and Linda has been granted non-qualified stock options from her 
employer. Both options have unique tax rules and holding periods, of which the 
Gellers have only minimal knowledge. They will need guidance on the best way to 
incorporate these options into their plan. They would like to exercise their options and 
sell the stock as soon as possible, but they are willing to wait if it will reduce the 
taxes due upon selling the stock. 

Estate planning 
The Gellers have amassed considerable wealth during their lifetime. They want to 
ensure that their children benefit from this wealth as much as possible. Jack and 
Linda admit that their knowledge of estate issues is lacking and this is the area where 
they require the most help. They have some goals for their estate when they die, but 
they are also willing to review some gifting opportunities during their lifetime. 
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Chapter 3: Family introduction 

Beneficiaries 
The Gellers are aware that they may have grandchildren in the future, but for now they 
have compiled a list of people whom they consider potential beneficiaries of their estate. 

Beneficiary Age Relationship 

Sarah Geller 28 Heir 

Matthew Geller 30 Heir 

American Cancer Society N/A 50% Charity 
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Chapter 4: Fact Finder 

Produced using NaviPlan Extended Version 9.0a, Emerging Information Systems Inc. 
Projections are based on assumptions that are believed to be reasonable. Actual results may vary, perhaps to a material degree. 
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4. Fact Finder 
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Client Name: Jack Geller 
  

Client Name: Linda Geller 
  

Advisor Name: Joe Planner 
  

Date (mm/dd/yy): January 1 – Current Year 
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Overview 
This Fact Finder is designed to help you gather the required information for your clients’ customized financial plan.  The questionnaire’s easy-to-follow 
format will allow you to enter your client’s required personal data and financial details. These items are necessary for you to create a complete and 
thorough picture of your clients’ current and future financial situation. 

The following sources will provide you with most of this information: 

• Latest investment statements from trust companies, brokers, investment companies, and banks 

• Latest mortgage and other loan statements 

• Budget of personal and living expenses 

• All life insurance and disability insurance policies 

• Pension statement from employer 

• Social Security Statement 

• Tax returns (Form 1040) 

• Latest will, power of attorney 

• Other relevant documentation 
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Client Information 
Base Family 

 Client Co-client 

Last Name: Geller Geller 
Given Name: Jack Linda 
Gender: Male Female 
Tax Filing Status (e.g., married filing joint, single): Married filing joint Married filing joint 
Date of Birth (mm/dd/yy/): February 1, 1944 March 14, 1946 
Social Security Number (optional):   
Number of Dependents: N/A N/A 
Address: 295 Colony Street 295 Colony Street 
City: Albany Albany 
State: New York New York 
Country: United States United States 
Zip Code: 12210 12210 
Home Phone Number: (518) 555-6655 (518) 555-6655 
Business Phone Number:   
Fax Number:   
Email Address:   
 
Dependents 

Name of Child or Dependent Dependent Of  
(Client, Co-client, Both or Other) Gender Date of Birth 

    

    

    

    

    

Advisors  

Advisory Type 
(Accountant, etc.) Full Name Address Business # 

    

    

    

    
Will Information 

 Client Co-client 

Is there a Will? (yes or no): Yes Yes 
What date was the Will last updated on?: January 1, 2002 January 1, 2002 
Where is the Will located? (safety deposit box, etc.): Safety deposit box Safety deposit box 
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Estate Beneficiaries  (Use this section to enter basic information about the beneficiaries of the estate. Dependents are automatically included as potential heirs.) 

 

Beneficiary Name 
 

Class 
(e.g., heir/charity/other): 

GSTT Applicable 
for Client 

(yes / no) 

GSTT Applicable 
for Co-client 

(yes / no) 

50% Charity 
(applies to charitable beneficiary only) (yes / no) 

Sarah Geller Heir No No No 

Matthew Geller Heir No No No 

American Cancer 
Society 

Charity No No Yes 

Additional Notes   (Use this section to enter any other Client information that you feel would be relevant to your client's financial plan.) 

*** Assumptions – Tax Options – select As legislated 

 

 

Assumptions 
 

Risk Profile   

Model Portfolio (if applicable): Balanced 
 

Milestones   

 Client Co-client 

Retirement Date (age or date) (mm /yy): Age 65 (February 2009) Age 65 (March 2011) 

Life Expectancy (age / year): Age 90 Age 90 

Disabled (age or year) (if applicable): N/A N/A 

Long-Term Care (age or year) (if applicable): Start: N/A End:   N/A Start: N/A End:    N/A 

 

Historical Data   

Unused Charity Deductions 

 50% Charities Non-50% Charities 

Years 
(previous 5 years) 

Non-Capital Gain Property 
(line 10)* 

Capital Gain Property 
(line 19)* 

Non-Capital Gain Property 
(line 16)* 

Capital Gain Property 
(line 24)* 

     

     

     

     

     
* Line references are from Table 4 of IRS publication 526. 

A.M.T. Carryforward Credit 

Form 8801 from last year's taxes - A.M.T. Minimum Tax Credit Carryforward  
(last line of Part II): 

 

Form 6251 from last year's taxes - Alternative Minimum Tax payable (line 35):  

Schedule D Line 23:   Line 19:   Line 23:   Line 32:   

Schedule D Tax Worksheet Line 4:   Line 7:   Line 9:   Line 20:   
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Capital Loss Carryovers 

 Client Co-client 
Loss Type Regular Tax A.M.T. Regular Tax A.M.T. 

Short-Term     
Long-Term     
Note: If there is no difference in the capital loss carryovers for A.M.T. purposes, enter the amount from the regular column in the A.M.T. column. 

Economic Factors   

Base Inflation Rate: %  3%  Return on Surplus Fund: %   Cost on Deficit Funds: %   

 

Assets 

House & Mortgage    (Non-income producing property only - income producing property is entered under Real Estate.) 

House 
 

Description Purchase 
Amount 

Ownership 
(client, Co-client, joint, community 

property) 

Purchase Date Market  
Value 

Growth Rate 

Jack & Linda’s House $1,000,000 Joint June 30, 1980 $3,000,000 3% 

      

Additional Notes   (Use this section to enter any House & Mortgage information that you feel would be relevant to your client's financial plan.) 

** Community Property – No  

 

Mortgage   (Non-income producing property only - income producing property is entered under Real Estate.) 

 Mortgage 1 Mortgage 2 Mortgage 3 

Description (e.g., first mortgage on 123 Main St.):    

Original Principal:    

Ownership (client, Co-client, joint):    

Start Date:    

Interest Rate:    

Amortization (years):    

Payment Frequency (e.g., weekly, monthly):    

Outstanding Principal Amount (if available):    

Outstanding Principal Date (relates to above):    

Insured (life on mortgage. both or none):    

Insured (disability on mortgage. both or none):    
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Real Estate  (Income producing property - use a separate sheet to enter additional information.)  

 Real Estate 1 Real Estate 2 Real Estate 3 
Name (identify property):    

Ownership (client, Co-client, joint, community property):    

Purchase Date:    

Purchase Amount:    

Market Value:    

Cost Basis:    

Property Growth Rate:    

Rental Income (monthly amount):    

Rental Expenses (monthly amount):    

Annual Rental Growth Rate (amount or percent):    

Additional Notes   (Use this section to enter any Real Estate information that you feel would be relevant to your client's financial plan.) 

 

 

Business Entities  (Income producing property - use a separate sheet to enter additional information.)  

 Business Entity 1 Business Entity 2 Business Entity 3 

Name (identify property): Commercial Properties LLC   
Type (LLC, Partnership, S Corporation, C Corporation) LLC   
Ownership (client, Co-client, joint, community property): Jack   
Purchase Date: May 1, 1995   
Purchase Amount: $500,000   
Start of Year Unit Value: $10,000   
# of Units: 50   
Market Value: $1,000,000   
Cost Basis: $675,000   
AMT Basis:  $750,000   
Growth Rate: 10%   
Income Activity for C Corporations: N/A   
     Annual Dividend per Unit: N/A   
     Frequency (annual, semi-annual, quarterly or monthly): N/A   
Income Activity for LLC, Partnerships, and S Corporations:    
     Income: $10,000   
     Expenses: $7,500   
     Distributions: $1,000   
     AMT Adjustments: $2,000   
     Frequency (annual, semi-annual, quarterly or monthly): Monthly   
     Indexed for inflation by: 3%   

Additional Notes   (Use this section to enter any Business Entity information that you feel would be relevant to your client's financial plan.) 
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Non-Qualified (Use a separate sheet to enter additional assets.) 

(Under Market Value enter each asset type's aggregate value as of the start of the year.  Break down each asset’s expected return rate based on its return component - e.g., if a Mutual Fund asset is 
earning 2% Interest, 2% Dividends, 4% Capital Gains and 4% Deferred Growth, you would enter  2-I, 2-D, 4-CG, 4-DG.  Or, you may prefer to include investment statements for any or all of this 
section.) 

Name 
(identify investment) 

 

Ownership 
(client, Co-client, joint, 
 community property) 

Purchase 
Date 

Cost  
Basis 

Market Value 
(start of year) 

Reinvest 
(reinvest all, 

don’t reinvest)* 

Rate of Return* 
(interest = I, dividend = D, capital 

gains = CG, deferred growth = 
DG, tax free = TF) 

Bond or T-
Bill Face 
Amount 

(if applicable) 

Strategic Growth 
Fund 

(Mutual Fund) 

 

Joint 

 

July 
1997 

 

$100,000 

 

$150,000 

 

Reinvest All 

Foreign Equity     10% 

Domestic Equity   15% 

Fixed Income      75% 

 

N/A 

Income Fund 

(Mutual Fund) 

Jack June 
1998 

$750,000 $1,000,000 Reinvest All Fixed Income      40% 

Cash                60% 

N/A 

XYZ Stock 
Portfolio 

Jack January 
1998 

$900,000 $1,400,000 Don’t 
Reinvest  

Foreign Equity     20% 

Domestic Equity   80% 

N/A 

Venture Stock 
Portfolio 

Jack January 
1998 

$80,000 $125,000 Reinvest All  Foreign Equity     60% 

Domestic Equity   40% 

N/A 

 

Jack’s Investment 
Portfolio 

 

Jack 

 

June 
1995 

 

$600,000 

 

$1,000,000 

 

Reinvest All 

Foreign Equity     20% 

Domestic Equity   20% 

Fixed Income      50% 

Cash                10% 

 

N/A 

Balanced Growth 
Fund 

(Mutual Fund) 

Linda August 
2000 

$25,000 $30,000 Reinvest All Foreign Equity     75% 

Domestic Equity   20% 

Fixed Income       5% 

N/A 

ABC Stock 
Portfolio 

Linda January 
1998 

$900,000 $1,400,000 Reinvest All Foreign Equity    20% 

Domestic Equity   80% 

N/A 

* Return rates are assigned by default. To change the rates select the override feature. 

*Dividend income that does not qualify for the rate reduction should be entered as interest income. 

Stock Options   (Use a separate sheet to enter additional stock options or attach copies of recent Stock Option statements.) 

Name 

Type 
(NSO or 

ISO) 

Ownership  
(client, Co-client, 

community property)  
Grant 

 
Current 

Unit Value Growth Rate 

Vesting* 
(e.g., immediately, 50% after 1 

year, 50% after 2 years): 

Expiry  
(e.g., 10 years  
after granting) 

   Grant Date Number of 
Options Strike Price     

ISO 2002 ISO Jack 
Jan 1, 
2002 5,000 $10.00 $20.00 11% 

20% immediately 

20% each year 
for 4 years 

10 years after grant 

NSO 2004 NSO Linda Jan 1, 
2004 

1,000 $20.00 $22.54 10% 100% 
immediately 

10 years after grant 

          

* Attach Vesting Schedule and other Stock Option Documents if available 

Additional Notes   (Use this section to enter any other Non-Qualified Asset information that you feel would be relevant to your client's financial plan.) 

** Auto-vest on Retirement and on Death for both ISOs and NSOs. 
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Deferred Annuities   (Use a separate sheet to enter additional annuities.) 
Annuity #1 

Name :   Type:   
             (e.g., Amount Certain, Term Certain, Life Income, etc.) 

Ownership :   Annuitant(s) : Client  Co-client  

Joint  First to Die  Last to Die  Percent to Survivor :   Beneficiary :  

Issue Date :  Account  type :  General   Separate  Initial Premium $: Cost Basis $:  

Balance or Market Value $:  Annuitization Start Date :  

Type of Annuitization :  Payment Frequency : Guaranteed Number of Years :  

Qualified     (Use a separate sheet to enter additional assets.) 

Beneficiary Name 
(identify investment) 

Ownership 
(client, Co-client)

Type 
(e.g., IRA,  

401k, other) 

Purchase 
Date 

Qualified 
Basis 

(if applicable) 

Market 
Value 

Rate of 
Return* 

Primary Contingent 

Jack’s SARSEP 

(Investment Portfolio) 
Jack SARSEP 

Dec. 31 - 
Previous 
year 

N/A $225,000 
Domestic Equity     50% 

Fixed Income        50% 

Linda Estate 

Linda’s 401(k) 

(Investment Portfolio) 
Linda 401(k) 

Dec. 31 – 
Previous 
year 

N/A $500,000 
Domestic Equity     40% 

Fixed Income        60% 

Jack Estate 

* Return rates are assigned by default. To change the rates select the override feature. 

*Dividend income that does not qualify for the rate reduction should be entered as interest income. 

Personal Use Assets   (Enter as a Lifestyle asset under the Detailed tab.) 

 Asset 1 Asset 2 Asset 3 Asset 4 

Name: Art Collection    
Ownership (client, Co-client, joint, community 
property): Joint    
Type (personal use property, collectibles, 
residence): Other Personal Assets    

Purchase Date: June 1995    
Purchase Amount: $900,000    
Growth Rate: 4%    
Market Value: $1,300,000    
 

Incomes 
Standard  

Description Member 
(client,  

Co-client) 

Amount 
(annual) 

Index Rate Applicable Period 
(while working, while retired, during LTC, 

both,  
other - e.g., Jan. 2000 - Dec 15 2002) 

% While 
Retired* 

% While 
Disabled* 

% While 
Survivor* 

% While  
in LTC 

Employment Salary: Jack $800,000 Inflation While Working 0% 0% 100% 0% 

Employment Salary: Linda $350,000 Inflation While Working 0% 0% 100% 0% 

Employment Bonus:         

Taxable Benefits:         

Net Self-employed earned:         
Net Self-employed 
commission:         

Alimony Payments Received:         
* The Percent While Retired, Percent While Disabled, and Percent While Survivor designations allow you to specify the percentage of  

Pre-retirement incomes the client will receive during each of these life stages. 
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Social Security   
 

(Please enter family members who may be eligible dependents for Social Security Disability and Survivor benefits in the Eligible Dependents Section below.)  

Eligible Dependents 

Dependent of 
(Client/Co-client) 

Dependent(s) 
(Name) Relationship 

   

   

   

   

   
 

Benefit Formula 
(Please provide a copy of your Social Security Statement to enter your monthly benefits in the Estimate Benefit section below.) 

Monthly Benefits from Social Security Statement 

Benefit For 
(Client/Co-client) At Full Retirement 

*Include 
Benefit 
(Yes/No) 

At Disability 
*Include 
Benefit 
(Yes/No) 

Surviving Spouse at Full Retirement
*Include Benefit 

(Yes/No) 

Jack 100% Yes N/A No 100% Yes 

Linda 100% Yes N/A No 100% Yes 
 

(Note:  The exact details of earnings history from your Social Security Statement can be entered directly in the Earnings History dialog in the Social Security section of 
NaviPlan using the Benefit Formula method.) 

Choose whether to include Retirement, Disability and Survivor benefits as part of your Financial Plan. 

Additional Notes   (Use this section to enter any other Income information that you feel would be relevant to your client's financial plan.) 

Employment Salary – Jack and Linda’s salary frequency is Monthly. 

Social Security benefits are indexed by inflation. Start Date is Age 65 for all applicable beneficiaries. 

Defined Benefit Pensions  
Please choose either the Estimate Benefit or Benefit Formula option below to complete applicable Pension information. 
(Attach pension statements or obtain information from the client’s company pension administrator. The calculations may be overridden and the pension benefits may be entered under the Benefit 
Payments tab.) 

Estimate Benefit  

 Pension 1 Pension 2 Pension 3 

Owner: (Client/Co-client)    

Benefits (% of final salary or estimated amount):    

Benefits Begin (age, date, at retirement or when disabled):    

Percent Payable to Survivor (If applicable):    

Benefit Indexing:    

Linked Incomes (income to which the pension applies):    
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Benefit Formula   

 (Attach pension statements or obtain information from the client’s company pension administrator. The calculations may be overridden and the pension benefits may be entered under the Benefit 
Payments tab.) 

 Pension 1 Pension 2 Pension 3 
Owner (client, Co-client):    
Description:    
Linked Incomes (income to which the pension applies):    
Pension Participation Date (eligibility or enrollment date):    
Number of Years Average Salary:    
Pension Formula (percent per year of service):    
Accrue Pension Credits while Disabled (yes / no):    

Benefits Begin (age, date, at retirement or when disabled):    

Percent Payable to Survivor (If applicable):    

Benefit Reduction for Survivor Coverage (if applicable):    

Benefit Indexing (specify maximum indexing if applicable):    

Normal Retirement Age (as specified by the pension plan):    

Percent Penalty for Early Retirement (per year);    

Minimum Retirement Age for Unreduced Benefit:    

 

Expenses 
Standard (If you share your common lifestyle expenses, just enter the total for one person.) 

Periodic (Expenses may be combined or broken down into sub-categories.) 

Description Member 
(Client, Co-client or 

Joint) 

% 
Deduct 

(if applicable) 

Amount and 
Frequency 

Index Rate Start Date End Date % While 
Retired* 

% While 
Disabled 

%While 
Survivor 

% While in 
LTC* 

Total 
Living 

Expenses 

Joint N/A $33,000 

Monthly 

Inflation Now Default 100% 100% 75% 100% 

Real 
Estate & 
Property 
Taxes 

Jack 100% $2,000 

Monthly 

Inflation Now Default 100% 100% 100% 100% 

*  The Percent While Retired, Percent While Disabled, Percent While Survivor, and Percent While in LTC designations allow you to specify the percentage of Pre-retirement expenses the client will 
receive during each of these life stages. 

Semi-Regular  

Expense 
Description

Member  
(Client,  

Co-client or 
Joint) 

% 
Deduct, 

(if applicable) 

Annual 
Amount 

Frequency 
(specify in years)

Index Rate Start Date End Date 
% While 
Retired* 

% While 
Disabled* 

% While 
Survivor* 

% While in 
LTC* 

Vacation Joint N/A $25,000 Every 2 
years 

Inflation July 
2007 

Age 70 100% 100% 50% 0% 

            
*  The Percent While Retired, Percent While Disabled, Percent While Survivor, and Percent While in LTC designations allow you to specify the percentage of Pre-retirement expenses the client will 

receive during each of these life stages. 
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Lump Sum  

Expense Description 
Member 

(Client, Co-client or Joint) Percent Deductible 
(if applicable) 

Amount 
Index Rate 

Date Effective 

      

      

 

Education (Education expenses should only be entered in this tab if specific assets are designated to cover them.  If an education expense is to be funded from cash flow, enter it under 
the Standard tab.) 

Member 
(For whom the 

expense is 
incurred) 

Type 
(e.g., Tuition fees, 
room and board) 

Description 
(e.g., Billy's 

College Fund) 
Amount and 
Frequency 

Index Rate Start Age 
(When student 

begins education)

Years 
(Number of years 
expense will be 

incurred) 
Linked Assets 

(Asset(s) used to fund this expense) 

        

        

        

Major Purchase (Major Purchase expenses should only be entered in this tab if specific assets are designated to cover them.  If a major purchase expense is to be funded from 
cash flow, enter it under the Standard tab.) 

Description 
(e.g., Wedding) Future Growth 

Rate 

Member 
(For whom the 

 expense is incurred) 

Amount Indexed by 
(%) 

Transaction 
Date 

Funding Assets 
(Asset(s) used to fund this 

expense) 

Sarah Geller’s 
Wedding 

0% Joint $30,000 0% July 2006 Balanced Growth 
Fund 

       

 
Emergency Fund (The Emergency Fund expense is intended to meet short-term cash flow needs.  A general guide should replace three months of employment income) 

Target Amount 
(Number of months 

expenses or specific $ 
amount) 

Type of Asset to 
Fund Goal 

(Typically short term 
investments) 

Current Savings 
Amount 

Savings Frequency Index Rate Savings Start Date Savings End Date 

       

       
 

Liabilities 
Detailed (Use a separate sheet to enter additional liabilities) 

 Liability 1 Liability 2 Liability 3 Liability 4 Liability 5 

Description:      
Owner (client, Co-client, joint):      
Payoff Option at Death:  

(i.e. Transfer to Survivor, Payoff at First 
Death, Insured for Life) 

     

Disability Insured (yes / no):      
Amortization Period (or end date):      
Start Date:      
Principal Amount:      
Principal Date (as of):      
Payment Type (e.g., interest only, PI):      
Payment Frequency (e.g., weekly, 
monthly):      

Interest Rate:      
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Additional Notes   (Use this section to enter any other Insurance information that you feel would be relevant to your client's financial plan.) 

 

 

 

 

Insurance 
Death Benefit Reinvestment Settings (Indicate how to invest the proceeds received from a life insurance policy.) 

Which investment vehicle would you like to use when investing Life Insurance proceeds?: Cash Account 
(e.g., Mutual Funds, Stocks, Bonds) 

What rate of return do you expect the invested Life Insurance proceeds to earn?:3% Interest 
Enter each asset type's aggregate value as of the start of the year.  Break down each asset’s expected return rate based on its return component - e.g., if a Mutual Fund asset is earning 2% Interest, 2% 
Dividends, 4% Capital Gains and 4% Deferred Growth, you would enter 2-I, 2-D, 4-CG, 4-DG. 

Life Insurance (Use a separate sheet to enter additional policies.)  

 Policy 1 Policy 2 Policy 3 

Description: Policy #2345   
Premium Payer (e.g., client, Co-client, joint, or other): Jack   
Type (e.g., term, universal): Term – 10 Year   
Insured (e.g., client, Co-client, joint 1st to die, other): Jack   
Effective Date: Dec. 31 – Previous year   
Policy Owner (e.g., client, Co-client, joint, or other): Jack   
Beneficiary (e.g., client, Co-client, joint 1st to die, other): Linda   
Premium Frequency (e.g., monthly): Monthly   
Premiums*: $1,000 Annually   
Death Benefit*: $400,000   
Coverage Ceases (age or date): Age 77   
Cash Surrender Value*: N/A   
* If the Death Benefits, Premiums, or CSVs are not level, attach the appropriate schedules. 

Additional Notes   (Use this section to enter any other Insurance information that you feel would be relevant to your client's financial plan.) 

** Increase premiums by 30% every 10 years. 

** Premiums cease at age 77. 

** Fields not mentioned above leave at default. 
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Disability Insurance (Use a separate sheet to enter additional policies.) 

 Policy 1 Policy 2 Policy 3 

Description (group LTD, group STD, individual disability):    
Insured Member:    
Owner:    
Effective Date:    
Monthly Benefit:    
Taxable (yes / no):    
Index for Benefit Amount:    
Waiting Period:    
Benefit Paid Until (years or age):    
Monthly Premium:    
Index Rate for Premium Amount:    

Additional Notes   (Use this section to enter any other Insurance information that you feel would be relevant to your client's financial plan.) 

 

 

 

Long-Term Care Insurance (Use a separate sheet to enter additional policies.) 

Long-Term Care Expenses 

Member Expense Type 
(medical, lifestyle, etc) 

Daily Amount Frequency Indexed by Inflation
 

Number of years 
applicable 

End Date 

Client       
       
       
Co-client       
       
       
 

 Policy 1 Policy 2 Policy 3 
Description:    
Insured Member:    
Effective Date:    
Tax Qualified (Yes or No):    
Daily Benefit:    
Per Diem Plan (Yes or No):    
Frequency (daily, monthly, etc.):    
Index for Benefit Amount During Long-Term Care:    
Index for Benefit Amount Before Long-Term Care:    
Waiting Period:    
Benefit Paid Until (years or age):    
Monthly Premium:    
Premium Payer:    
Index Rate for Premium Amount:    
Premiums Cease (date or age):    
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Additional Notes   (Use this section to enter any other Long Term Care Insurance information that you feel would be relevant to your client's financial plan.) 

 

 

 

 

Estate Planning 
Use this section to tell us about estate planning strategies that the client already employs, or that you will suggest as part of the financial plan.   
Use the back of this sheet to enter additional information. 

General   
Additional Fees and Taxes   (Use this section to enter any additional fees that may be calculated on the estate at disposition.) 

State Death  
Tax Rate 

(% or $) 

Probate  
Fee Rate 

(% or $) 

Administration  
Fee Rate 

(% or $) 

Client Co-client Client Co-client Client Co-client 

Default rate for 
New York 

Default rate for 
New York 

1.0% 1.0% 1.0% 1.0% 

      

 

Historical Data (Use this section to enter information about historical estate taxes.) 

 Client Co-client 

Taxable Lifetime Gifts:   
Gift Taxes Already Paid:   
Lifetime GSTT Exemption Used:   

Additional Notes   (Use this section to enter any other Insurance information that you feel would be relevant to your client's financial plan.) 

Use the Mirror Wills/Either Dies First method for the estate plan. 

 

Funded Trusts 
(Use this section to enter basic information regarding any Trusts that have been previously funded.  Please provide a copy of Trust documents.) 

 Trust 1 Trust 2 Trust 3 Trust 4 Trust 5 

Trust Type (i.e. Irrevocable): ILIT     
Created On: Dec 31, 2000     
Grantor (if applicable): N/A     
Start of Year Cost Basis: N/A     
Start of Year Market Value: N/A     

Return Rate:  

(Annual) 

2% Interest 

2% Dividends 

4% Deferred Growth 
   

 

Trust Tax Rate: 40%     

Income Beneficiaries (Name and 
%): 

Matthew Geller 

Sarah Geller 
   

 

Remainder Beneficiaries (Name 
and %): 

Matthew Geller 

Sarah Geller 
   

 

Note:   If there are details that are not specified above (i.e. Trust term, GSTT Inclusion Ratios) attach Trust documents.  Include any Credit Shelter Trusts, Marital Trusts or QTIPs that were created as a 
result of a former spouse’s death. 
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Additional Notes   Use this section to enter any other Estate Planning information that you feel would be relevant to your client's financial plan. 

Existing ILIT – Beneficiaries are Pro-rata 

                  Trust tab – Gifts to Trust in 2003 and 2002 - $7,500 annual 

                                Transfer to Trust – 2000          Crummy Trust – selected 

                                Percentage of Death Benefit Payable to Trust – 100% 

                 Policy tab - Universal Life Policy – Premium Payer is Joint – Joint 2nd to Die policy 

                               Premiums - $7,500 annual – cease at Age 70 

                               Death Benefit - $500,000 

                               CSV – Current - $25,000 – payable with death benefit 

                               CSV – Future – increase 3% (Fill value every year) 

All other fields remain at default. 

Family Limited Partnership Information   (Use this section to enter basic information regarding any Family Limited Partnership that the client has established.) 

General 

 Trust 1 Trust 2 Trust 3 

FLP Name:    
Date Created:    
Marketability Discount:    
Minority Interest Discount:    
Market Value:    
Cost Basis:    
Return Rates:    

Partner 

 Partnership 1 Partnership 2 Partnership 3 

Partners:    
Partner Type (general, limited, or both):    

Income Distributions 

 Distribution 1 Distribution 2 Distribution 3 Distribution 4 

Income Distribution Amount:     
Frequency (annual, monthly or lump sum):     
Index Rate:     
Start Date:     
End Date:     
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Gifting 

 Gift 1 Gift 2 Gift 3 Gift 4 

Gift By (gift from limited partnership interest):     
Gift To (beneficiary):     
Frequency (annually or lump sum)     
Amount (Dollar amount or Maximum Annual Gift Exclusion):     
Index Rate:     
Start Date:     
End Date:     
 

Gifting History (Use this section to enter estate gifting information.) 

 Gift 1 Gift 2 Gift 3 Gift 4 Gift 5 

Description:      
Beneficiary Name:      
Growth Rate (on property given to beneficiary):      
Tax Rate:      
Net After Tax Growth:      
Prior Gifts From Client Including Growth (cash & 
asset gifts):      
Prior Gifts From Co-client Including Growth (cash & 
asset gifts):      

Prior Bequests From Client, Including Growth:      
Prior Bequests From Co-client, Including Growth:      

Gifting: Current Strategies 

 Gift 1 Gift 2 Gift 3 Gift 4 Gift 5 

Description:      
Gifting Strategy (i.e. Cash gift, Asset gift)      
Amount:      
Applicable Period:       
Beneficiary Name:      

Estate Expenses (Use this section to enter information about expenses for the decedent.) 

 Expense 1 Expense 2 Expense 3 Expense 4 

Owner (client, Co-client, first to die, second to die): Jack Linda   
Expense Name (eg Burial): Burial Expense Burial Expense   
Amount: $10,000 $10,000   
Index To Inflation (yes / no): Yes Yes   
 

Will Information 

Family Member 
(Client/Co-client) 

Cash Bequests 
(Yes/No) 

Asset Bequests 
(Yes/No) 

Credit Shelter 
Trusts 
(Yes/No) 

Marital Trust 
(Yes/No) 

Living Trust 
(Yes/No) 

QTIP Trust 
(Yes/No) 

Other 
Testamentary 

Trusts 
(Yes/No) 
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Additional Notes   Use this section to enter any other Estate Planning information that you feel would be relevant to your client's financial plan. 

 

 

 

 

Other Tax 

Misc. Credits & Deductions  

  Miscellaneous Deductions Miscellaneous Credits Applicable To 

Owner Description Above the Line Below the Line Refundable Non-refundable (federal, state or both) 

       

       

       

       

       
 

Additional Notes   (Use this section to enter any Other Tax information that you feel would be relevant to your client's financial plan.) 

 

 

Strategies 
Use this section to tell us about any planning strategies that you are currently applying (e.g., regular savings to an investment, additional payments toward a loan’s principal, etc).  Use a separate sheet to 
enter additional strategies. 

Savings (Use the following section to list Savings plans that are currently in place.) 

Regular (Savings made on a regular, periodic basis.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Asset Name:     
*Maximize Contributions (Yes/No) :     
Contribution Amount:     
Frequency (e.g., monthly, weekly):     
Index Rate:     
Savings Period (while I’m working, while I’m retired, both, 
until LTC, other - e.g., Jan. 1990 - Dec 2025):     

Lump Sum (Savings made in one or more lump sums.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Asset Name:     
*Maximize Contributions (Yes/No) :     
Amount:     
Index Rate:     
When is this Transaction Applicable? (upon retirement, upon 
disability, upon death, other - e.g., Jan. 15, 2003):     
 
*Applies only to IRA accounts 
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Surplus (Savings put toward an asset using surplus cash at year-end.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Asset Name:     
Percent Of Surplus (e.g., half or 50%):     
Savings Period (while I’m working, until age 71, other - e.g.,  
Jan 1, 1995 to Dec 31, 2011):     

Employer-Sponsored Pensions (Savings put into plans that are established by the employer.) 

 Plan 1 Plan 2 Plan 3 Plan 4 

Asset Name: Jack’s SARSEP Linda’s 401(k)   
Maximize Qualified Plan Contributions (Yes/No) : No Yes   
Employee Pre-tax Amount: $13,000 N/A   
Employee Post-tax Amount: N/A N/A   
Employer Amount: $13,000 $10,500   
Frequency (e.g., monthly, weekly): Annual Annual   
Index Rate: $1,000 per year N/A   
Savings Period (while I’m working, until age 71, other - e.g.,  
Jan 1, 1995 to Dec 31, 2011): While Working While Working   

Additional Notes   (Use this section to enter any Strategy information that you feel would be relevant to your client's financial plan.) 

 

  

 
Debt Reduction (Use the following section to list Debt Reduction plans in which your client is already taking part.) 

Regular (Any payments made directly toward the principal of an existing loan. 

                (These are over and above the required payments that are automatically defined for the liability.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Liability Name:     
Amount:     
Frequency (e.g., monthly, weekly):     
Index Rate:     
Payment Period (while I’m working, while I’m retired, both, 
other - e.g., Jan. 1990 - Dec 2011):     

Lump Sum (Payments made in one or more lump sums toward the principal of an existing loan.   

 These are over and above the required payments that are automatically defined for the liability.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Liability Name:     
Amount:     
Index Rate:     
Payment Date (upon retirement, upon disability, upon death, 
other - e.g., Jan. 15, 2003):     

Surplus  (Savings put toward the principal of an existing loan using surplus cash at year-end.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Liability Name:     
Percent Of Surplus (e.g., half or 50%):     
Payment Period (while I’m working, until age 71, other - e.g.,  
Jan 1, 1995 to Dec 31, 2011):     
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Redemptions  (Use the following section to list asset Redemption plans which your client has already established.) 

Regular  (Any redemptions from an asset made on a periodic basis.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Asset  Name:     
Amount:     
Frequency (e.g., monthly, weekly):     
Index Rate:     
Redemption Period (while I’m working, while I’m retired, 
both, other - e.g., Jan. 1990 - Dec 2011):     
 

Additional Notes   (Use this section to enter any Strategy information that you feel would be relevant to your client's financial plan.) 

 

 

Lump Sum  (Redemptions from an asset in one or more lump sums.) 

 Plan 1 Plan 2 Plan 3 Plan 4 

Asset Name:     
Amount:     
Index Rate:     
Redemption Date (fixed date, or upon retirement, disability 
or death):     

Complete Regular  (Redemptions from an asset that will completely deplete it at the end of a defined period.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Asset  Name:     
Frequency Of Sells (e.g., annually, monthly):     
Index Rate:     
Redemption Period( while I’m retired, other - e.g., Jan. 1990 
- Dec 2011):     

Transfers  (The transfer of funds from one asset to another.) 

 Strategy 1 Strategy 2 Strategy 3 Strategy 4 

Source Asset:     
Destination Asset:     
Amount:     
Transaction Date (fixed date, or upon retirement, disability, 
or death):     
 

Additional Notes   (Use this section to enter any Strategy information that you feel would be relevant to your client's financial plan.) 
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Other Information 
 (Use this section to enter any other information that you feel would be relevant to your client's financial plan.)  
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5. Financial planning strategies 

Objectives 
The Gellers are interested in exploring several financial scenarios in the hopes of 
achieving an optimal financial plan. 

The Gellers have expressed interest in selling the family home and purchasing a condo at 
retirement. They feel that if they downsize they may be able to take advantage of other 
opportunities using the proceeds they receive from their home.  

A business associate has talked to Jack about forming a business together in retirement. 
Jack and Linda think that this is a good opportunity. They want to know if it would be 
best to finance this venture with a loan or cash on hand. 

Both Jack and Linda have acquired stock options and are interested in exercising their 
options and selling some of the underlying shares. However, they are unsure how to 
minimize both their cash outlay and their incurred taxes. 

Observations 
The Plan Analysis window allows you to see an instant analysis of the active plan. 

Procedure 
• From the desktop, double-click the Base Plan icon. 

The Plan Analysis window opens. 

The Plan Analysis window shows that the Gellers will experience some cash flow 
surpluses during their pre-retirement period. During our initial meeting the Gellers 
mentioned that they usually have excess cash at the end of the year. They usually invest 
all excess cash in one of their accounts. We also see that their projected net worth climbs 
continuously throughout the entire planning period. 

Planning strategy: house downsize 
Jack and Linda have expressed interest in selling the family home and buying a condo 
when they are both retired. With their two children living on their own, they feel that a 
smaller living space would be much more manageable. They would like to know if there 
would be any proceeds left to use for other business and investment opportunities after 
the sale of the home and the purchase of the condo have been completed. 

Procedure 
1. Right-click the Base Plan icon, and then select Duplicate. 

2. On the General tab, rename the new plan House Downsize. 

3. Go to the Assets category – Detailed tab. 

4. Double-click Jack & Linda’s House. 

The Asset Details dialog box opens. 
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5. Go to the Sells tab, click Insert, and then select Lump Sum. 

6. Select Redeem all units, and then under Triggered by the following occurrence, 
select When individual enters retirement. 

7. Click OK twice. 

8. To add a new lifestyle asset, click Insert, and then select Lifestyle. 

9. On the Details tab, enter the following: 

Name: New Condo Ownership: Joint 

10. Go to the Buys tab, click Insert, and then select Lump Sum. 

11. In the Amount field, enter $1,000,000, and then select the In Today’s Dollars 
check box. 

12. In the Effective section under Triggered by the following occurrence, select When 
individual enters retirement. 

13. Click OK twice. 

14. Go to the Expenses category – Retirement tab – Expenses subtab. 

15. Double-click Real Estate and Property Taxes. 

16. Under When member’s status is, in the Retired field, enter 50%. 

17. Click OK. 

18. To add a new expense, click Insert, and then select Insert Periodic – Housing. 

19. Go to the Advanced tab, and then enter the following: 

Source: Condo Maintenance Fees Monthly: $500 

Start Date: Retirement Date – First of Jack and Linda’s End Date: default 

Index from 2009 by Inflation Rate: selected  

When member’s status is Disabled: 100% all fields  

When member’s status is LTC: 100% all fields  

20. Click OK. 

21. Click OK, and then click Yes to finish editing the current plan. 

The results 
First, determine the proceeds that will be received when the house is sold. As well, 
determine the excess proceeds, if any, that will be left after the new condo is 
purchased and any applicable capital gains taxes have been paid. 

Procedure: determining proceeds from sale 
1. Go to the Reports menu, and then select Net Worth – Single Asset. 
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2. The Single Asset Document Generator dialog box opens. Under Asset, select 
Jack & Linda’s House (Joint). 

3. In the Number of years to project field, enter 10, and then under Reports, 
select Single Asset Summary. 

4. What are the projected proceeds from the sale of Jack and Linda’s house in 
2009? 

 

5. Close the Single Asset Summary report and the Single Asset Document 
Generator dialog box. 

Procedure: determining net proceeds 
1. Double-click the House Downsize icon to display the Plan Analysis window. 

2. In the Plan Analysis window, you can see a large surplus in 2009. 

Double-click the year 2009 (the year Jack retires) to open the Cash Flow 
Assistant. 

3. Double-click the Received Capital category for the family. The tax-free 
capital received from the sale of the house is listed. 

[$1,000,000 (purchase price) + $500,000 (exclusion)] 

4. Click OK. 

5. Double-click the Investment Income category for the family. The taxable 
gain received from the sale of the house is listed.  

6. Click OK. 

7. Double-click the Lifestyle Expenses category for the family. The cost of the 
new condo is listed, indexed to inflation. 

8. Click OK. 

9. The net proceeds can be calculated using the following steps: 

Taxable gain  $       1,986,517 
Capital gain tax rate 20%
Taxes on the gain  $          397,303 
 
Gross proceeds from sale of home  $       3,486,517 
Less: New condo (inflated amount)  $     (1,159,274)
Less: Taxes on the gain  $        (397,303)
Net proceeds  $       1,929,940 

 

Jack and Linda would like to invest the net proceeds in one of their existing 
assets. 
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Procedure: investing net proceeds 
1. In the Cash Flow Assistant, click Edit Data, and then select Assets – Non-

Qualified Assets. 
2. Double-click Strategic Growth Fund, and then select the Buys tab. 

3. To add a buy record, click Insert, and then select Lump Sum. 

4. In the Amount field, enter $1,929,940. 

5. In the Effective section under Triggered by the following occurrence, select 
When Individual enters retirement. 

6. Click OK three times, and then click Yes to get back to the Cash Flow 
Assistant. 

The ending surplus has been reduced. 

7. Click OK when finished. 

Using the Plan Analysis window, compare the net worth graphs between the 
Base Plan and House Downsize plan. 

Planning strategy: S corporation endeavor 
A friend has approached Jack and has asked him to become a shareholder in a business 
endeavor he is starting. The business will be formed as an S corporation to take 
advantage of the flow through of taxes to the shareholders. In the initial start-up phase, 
there are no distributions expected from the business. An income projection has been 
provided that shows there is potential for future distributions. Jack and Linda think that 
even though they are not going to gain cash flow from the endeavor, this would be a good 
way to ease into retirement. It will give Jack another focus while he adjusts to their new 
lifestyle in retirement.  

The endeavor would include an upfront capital contribution of $500,000 with the 
possibility of additional capital contributions during the next few years. The concern that 
the Gellers have is whether they should fund the initial capital through cash on hand or if 
it would be more prudent to fund this contribution using a loan. They want to ensure that 
they have enough funds so as not to compromise their retirement plans. They would also 
like to see the impact this venture would have on their net worth over the course of their 
plan. 

Procedure 
1. Minimize the Plan Analysis windows. 

2. Right-click the House Downsize icon, and then select Duplicate. 

3. On the General tab, rename the new plan S-Corp without Loan. 

4. Go to the Assets category – Business Entity tab. 

5. Click Insert. 

6. Name the business entity S-Corp venture. 
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7. In the Business Entity (Details) dialog box, enter the following details about the 
S-corporation: 

Ownership: Jack Type: S corporation 

Purchase Date: Oct 1, 2008 Purchase Amount: $500,000 

AMT Basis: $0 Growth Rate: 4% 

Income: $25,000 Monthly Expenses: $15,000 Monthly 

Index to Inflation Rate: cleared  

8. Click OK. 

9. To include the additional capital that the shareholders will contribute to the 
corporation over the next 10 years, click the Future Additions button. 

10. Click Insert, and then select Periodic. 

11. Enter the following information regarding the future capital that will be put into 
the business: 

Amount: $100,000 Frequency: Annual 

Indexed to inflation: No Buy Period: Jan 1, 2009 – Jan 1, 2018 

When Status Is: Pre-retired and Retired selected  

12. Click OK, and then click Done to return to the Business Entity tab. 

13. Click OK, and then click Yes to finish editing the current plan. 

The Gellers are deciding if they should fund this capital contribution with a loan 
of $375,000 rather than with cash on hand. A great way to review the outcome of 
the plan using a loan rather than cash on hand is to duplicate the plan and add a 
loan to it, and then compare the two plans side by side. 

14. Right-click the S-Corp without Loan icon, and then select Duplicate. 

15. On the General tab, rename the new plan S-Corp with Loan. 

16. Go to the Assets category – Business Entity tab, and then select the S-Corp 
venture entity. 

17. Click the Loans button, and then click Insert to insert the details of the loan for 
the purchase of the S corporation. 

18. Enter the following details about the loan to fund the purchase of the business: 
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Ownership: Jack  

Payoff Options at Death: Payoff at owner’s death (at estate)  

Loan Date: Oct 1, 2008 Loan Ends: Oct 1, 2018 (10 years) 

Bring into cash flow: selected Original Principal: $375,000 

Payment Information: Principal & Interest Frequency: Monthly 

Annual Interest Rate: 7% Compounded: Semi-annual 

19. Click OK twice to return to the Business Entity tab. 

20. Go to the Liabilities category. The loan appears here and an Asset Link for the 
loan is automatically created. 

21. Click OK, and then click Yes to finish editing the current plan. 

22. Using the Plan Analysis window for the S-Corp without Loan and the S-Corp 
with Loan plans, compare the pre-retirement cash flow between the two plans. 

The results 
In both plans the accumulated surplus cash is utilized by the year 2010. This allows 
us to assume that neither situation will adversely impact the Geller’s financial ability 
to carry out their original plans for early retirement. 

From a planning standpoint, if Jack is going to be taxed on earned income from the 
business, and will not receive distributions of income, it may be better to keep their 
cash available for other things and use a loan to buy into the business venture. This 
approach allows the Gellers to spread out the cost of the initial purchase and not run 
short on cash during their earlier retirement years. Also, if a loan is used to make the 
purchase, the liability interest can be deducted for tax purposes and it will provide 
some benefit to them in the start-up years of the business. Therefore, even though 
they are not receiving income in their hands they are receiving some benefit from this 
investment. 

Later, if the business begins to distribute cash to them, perhaps those income 
distributions could offset the remaining loan payments. This may be a more 
conservative way to approach the situation, as it would leave more surpluses available 
during the pre-retirement years. 

To ensure that the S corporation is flowing into their plan and to see the earned 
income on which they will be taxed, you should review some reports. 

1. Select the S-Corp with Loan plan. 

2. Go to the Reports menu, and then select Cash Flow – Current Year Details for 
Family. 

3. In the Report Year field, enter 2008. 
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Ensure that the initial capital contribution has gone to purchase the S corporation. 
Review the Received Capital section to ensure that the proceeds from the liability 
have come into the plan. 

4. Using the Report Year button, scroll forward to 2009. 

The Current Year Cash Flow Details for Family report allows you to see the 
future additions of capital that are going toward the S corporation reflected as 
purchases in the Employment/Business Expense section of the report. 

You can also see the principal and interest payments for the loan in the Investment 
Expenses section of the report. The interest portion of the loan payment is 
considered deductible for tax purposes. 

5. To see the details of the corporation and assess how it may affect the plan, go to 
the Reports menu, and then select Net Worth – Single Asset.  

6. In the Single Asset Document Generator dialog box, select S Corp venture 
(Jack) from the Asset list, and then enter 10 in the Number of years to project 
field.  

7. Click the Reports button, and then select Single Asset Detailed. 

8. Scroll down the report to the details for the year 2008. 

From the Single Asset Detailed report, the business income and expenses of the S 
corporation will appear. From the projections of the business that Jack’s friend 
provided him with, it appears as though Jack will receive business income from 
the endeavor in the early years of the investment and may receive distributions 
later on.  

9. Go to the Reports menu, and then select Net Worth – Single Liability. 

10. In the Single Liability Document Generator dialog box, select Loan for S-Corp 
venture (Jack) from the Liability list, and then enter 10 in the Number of years to 
project field.  

11. Click the Reports button, and then select Single Liability Summary. 

From the Single Liability Summary report, review the amount of the principal and 
interest payments on the loan for the S corporation. If the projected distributions 
exceed the payment amount of the loan, the Gellers would receive two benefits 
from the endeavor: tax deductibility in the early years, and cash flow to offset the 
loan payments in the later years. 

12. Go to the Reports menu, and then select Income Tax – Details for – Jack. 

It would also be wise to review the income tax situation for Jack to see how the 
business income flows to him. The Gellers already have an LLC that produces 
business income in their plan. To see the tax effect of the S corporation, compare 
the income tax reports that include the S corporation with those that do not. 

13. Enter 2009 in the Report Year field. 

14. Click the scale, and then select Base Plan (current year) to compare this report 
to the income tax report that does not include the S corporation. 
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15. Click OK. 

Ensure both reports show the year 2009. 

Compare the Ordinary Business Income portions of the reports. 

The income reported as Ordinary Business Income attributed to the S corporation 
in 2009 is $120,000 ($154,778 - $34,778). This is the same figure that is reported 
in the Single Asset Detailed report for the year 2009. In the Single Asset Detailed 
report, the Ordinary Business Income minus the Ordinary Business Expense is 
equal to the taxable business income for 2009, or $120,000. 

Going forward we will suggest that the Gellers implement the S corporation 
venture, but that they do so using a loan for the initial capital contribution and 
take the future additions of capital from cash on hand. 

Planning strategy: exercising and selling Jack’s incentive stock 
options 
In 2002, Jack’s employer rewarded him with the option to purchase 5,000 shares in the 
company at a strike price of $10.00. This option was subject to a vesting schedule where 
20% of the stock was available immediately for purchase. The remaining shares will vest 
20% each year over the next four years. However, a provision within the option states 
that all unvested shares will vest immediately upon retirement or in the event of Jack’s 
death. This provision also stipulates a 10-year period to purchase all vested shares or the 
option will expire. Based on favorable market conditions, the share value has increased to 
$20.00 as of January 1, 2004. 

Jack has decided he would like to exercise and sell all his company stock to provide 
additional cash for retirement. What tax implications would arise if all shares were sold 
within the one-year holding period versus selling all shares after the required holding 
period? Jack will execute this transaction based on the most tax-favorable alternative. 

Procedure 
1. Minimize the Plan Analysis windows and reports. 

2. Right-click the S-Corp with Loan icon, and then select Duplicate. 

3. On the General tab, rename the new plan Stock Option Analysis. 

4. Go to the Assets category – Non-Qualified tab. 

5. Double-click ISO 2002. 

6. In the Asset Details dialog box, review the data entry for the stock option. 

7. Go to the Exercise subtab. 

8. Enter an exercise date of Dec 1 2008, and then select the All Vested check box. 

9. Click OK when finished. 

10. Go to the Strategies category – Redemptions tab – Lump Sum subtab. 
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11. To sell the exercised options, add a redemption strategy. Click Insert, and then 
select ISO 2002 (Jack). 

12. Click Edit. 

13. In the Date field, enter Jan 1 2009, and then select the Total Market Value 
check box. 

14. Click OK. 

15. Click OK, and then click Yes to finish editing the current plan. 

The results 
1. Go to the Reports menu, and then select Net Worth – Stock Option Activity – 

Gross $. 

2. In the Projection Criteria dialog box, change the Ending Year field to 2009, and 
then under Members to include, select Jack. 

3. Click OK. 

The Stock Option Activity (Gross $) report displays all applicable activity 
regarding the exercise of options and the sale of the underlying stock. The Gross 
Granted column is blank because Jack received the ISOs in 2002 and the report 
begins in the current year, 2004. 

• The Gross Vested column displays the total amount of ISOs that vested at the 
end of each year. For example, the amount for 2004 is the gross amount of 
ISOs that vested at the end of the year (20% or 1,000 ISOs) multiplied by the 
unit price of the shares as of the end of 2004, which includes the 11% growth 
rate for the year (1,000 ISOs x $22.201). Remaining unvested ISOs will vest 
over the next two-year period. 

• The Amount Paid to Exercise column displays the 5,000 ISOs exercised at a 
strike price of $10.00 in the year of 2008. 

• The Gross Exercised column displays the 5,000 ISOs exercised on Dec 1, 
2008, at the market value of the stock at the end of that year (Dec 31, 2008), 
equaling $168,5062. 

• The Gross Expired column displays the total amount of ISOs that Jack did not 
exercise and that have subsequently expired. This is not applicable in this 
scenario, as Jack has exercised all of his ISOs. 

• The Taxable Compensation Income column displays the amount of income 
that will be included as taxable compensation upon the exercise and sale of 
shares of NSOs. Jack does not have any taxable compensation income for 
2008, as his options are ISOs. Since the shares are sold within 12 months, 

                                                 
1 The unit value of $20.00 as of January 1, 2004 plus 11% growth for 1 year ($20.00 x 1.11). 

2 The unit value of $20.00 as of January 1, 2004 plus 11% growth for 5 years ($20.00 x 1.11 ) multiplied by 5,000 ISOs. 5
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taxable compensation income of $117,1143 is realized on the sale date in 
January 2009. 

• The A.M.T. Income column displays the difference between the option price 
($50,000) and the fair market value of the stock upon exercise of the ISOs 
(Dec 1, 2008). This is subject to the alternative minimum tax and equals 
$117,114. The alternative minimum tax calculation is presented in greater 
detail in the Income Tax Details for Jack report. 

• The Gross Sold column displays all of the shares that have been sold. Jack 
sold all shares in January 2009 for a total market value of $168,5064. 

• The Net Value column displays the total net value of all shares exercised. For 
example, the value for 2004 is $36,6005, which is calculated as the gross 
amount of ISOs vested by the end of 2004 minus the cost of exercising the 
ISOs. 

4. Minimize the Stock Option Activity (Gross $) report. 

5. Go to the Reports menu, and then select Income tax – Details for – Jack. 

6. In the Report Year field, advance the report to 2008.  

7. Under Alternative Minimum Tax, click Expand. 

8. Within the report, scroll to the Alternative Minimum Tax section. 

The report illustrates the calculation of the alternative minimum tax amount in the 
year that Jack exercises his ISOs. 

9. Advance the report to 2009, and then scroll to the Calculation of Total Income 
section of the report. 

The difference between the market value of the shares at sale (January 2009) and 
the market value at the time of exercise (December 2008) is treated as a short-
term capital gain because the holding period is less than one year. The report 
shows $1,392 of short-term capital gains realized in 2009. 

10. Minimize the Income Tax Details for Jack report. 

11. Go to the Reports menu, and then select Net Worth – Single Asset. 

The Single Asset Document Generator dialog box opens.  

12. Under Asset, select ISO 2002 (Jack). 

13. In the Number of years to project field, enter 7. 

14. Click Reports, and then select Single Asset Income Distribution. 

                                                 
3 Market value per unit at exercise (Dec 1, 2008) minus strike price multiplied by the number of options (($33.42 – 10.00) X 5000).

4 The unit value of $20.00 as of January 1, 2004 plus 11% growth for 5 years ($20.00 x 1.11 ) multiplied by 5,000 ISOs5

5 [(3,000 x $22.20 unit value as of end of 2004 ) – (3,000 ISO’s x $10 strike price)]. 
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The Single Asset Income Distribution report confirms that the short-term capital 
gain was income generated from the sale of all the shares (i.e., interest vs. capital 
gains).  

15. Go to the Strategies menu, and then select Cash Flow Assistant. 

16. Scroll to 2009, and then under the Jack column, double-click the Employment 
Income field. 

If all shares are sold within one year of the exercise date, the difference between 
the fair market value at the time of exercise and the strike price is taxed as 
ordinary income. This amount is also subject to AMT. 

Selling Jack’s shares within the one-year holding period does not seem to provide any 
favorable tax breaks. Let’s produce a plan to show Jack what would happen if Jack 
held the stock an additional year before he sold it. 

Procedure 
1. Click OK twice to go back to the desktop. 

2. Minimize the Single Asset Income Distribution report, and then close the Single 
Asset Document Generator dialog box. 

3. Right-click the Stock Option Analysis icon, and then select Duplicate. 

4. On the General tab, rename the alternate stock option strategy Stock Option 
Analysis Delayed Sale. 
By duplicating the original Stock Option Analysis plan and then entering a later 
sale date for the shares, you will be able to provide a side-by-side comparison of 
the two situations and help Jack make an informed decision about the best time to 
sell the shares. 

5. Go to the Strategies category, and then to the Redemptions tab. 

6. Go to the Lump Sum subtab, select ISO 2002 (Jack), and then click Edit. 

7. In the Date field, enter Jan 1 2010.  

8. Click OK. 

9. Click OK, and then click Yes to finish editing the current plan. 

The results 
1. Go to the Reports menu, and then select Net Worth – Single Asset. 

The Single Asset Document Generator dialog box opens. 

2. Under Asset, select ISO 2002 (Jack). 

3. In the Number of years to project field, enter 7. 

4. Click Reports, and then select Single Asset Income Distribution. 

5. Go to the Strategies menu, and then select Cash Flow Assistant. 
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6. Scroll to 2010, and then under the Jack column, double-click the Investment 
Income field. 

If the ISOs are held for more than two years after the grant date and more than 
one year after the exercise date, then the difference between the selling price of 
the shares and the strike price is considered a long-term capital gain and will be 
noted as such in the Cash Flow Assistant and in the Single Asset Income 
Distribution report. 

7. Click OK twice to get back to the desktop. 

8. Compare the Single Asset Income Distribution report for the Stock Option 
Analysis plan and the Stock Option Analysis Delayed Sale plan.  

From a tax standpoint, it is advantageous for Jack to wait until 2010 to sell his 
company stock, assuming the stock’s value grows according to our projections. In 
2010, income from the sale will be taxed as a long-term capital gain. Prior to 
2010, income from the sale will be taxed as employment income. 

Planning strategy: cashless exercise of Linda’s NSOs 
In 2004, Linda’s employer awarded her the option to purchase 1,000 shares in the 
company at a strike price of $20.00. This option was granted without a vesting schedule 
(i.e., all shares are available for purchase immediately). However, the option did come 
with a provision that stipulates a 10-year period in which to purchase all vested shares or 
the options will expire. The stock is expected to increase in value and Linda would like to 
exercise her options in 2008 to make the stock available for funding retirement, if needed. 

Procedure 
1. Minimize all the reports on the desktop, and then close the Single Asset 

Document Generator. 
2. Ensure the Stock Option Analysis Delayed Sale icon is selected. 

3. Go to the Data menu, and then select Assets – Non-Qualified Assets. 

4. Double-click NSO 2004. 

5. The Asset Details dialog box opens. Review the data entry for the stock option. 

6. Go to the Exercise subtab. 

7. Enter an exercise date of Dec 1, 2008, and then select the All Vested check box. 

8. Select the Cashless Activate? check box, and then enter an Estimated Tax Rate of 
28%. 

9. Click OK when finished. 

10. Click OK, and then click Yes to finish editing the current plan. 

The results 
1. Go to the Reports menu, and then select Net Worth – Stock Option Activity – 

Gross $. 
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The Projection Criteria dialog box opens. 

2. In the Ending Year field, enter 2009, and then under Members to include, select 
Linda. 

3. Click OK. 

The Gross Sold column represents the dollar value of the shares that must be sold 
to fund the cashless exercise, including any taxes on the sale of shares. 

• Calculate the amount paid to exercise. 

1,000 shares x $20 strike price = $20,000 

Broker loans client $20,000 to complete the cashless exercise. 

• Broker sells enough shares at fair market value (as of Dec 1, 2008) to cover 
the loan. 

$20,000 / $36.036 = 555.09 shares 

• Broker sells enough shares to cover taxes on the gain triggered by the sale of 
the shares (i.e., taxable compensation income). 

[$36.03 (FMV) – $20.00 (strike price)] x 1,000 shares = $16,030 

• Calculate the taxes withheld to determine the shares sold. 

$16,030 x 28% / $36.03 = 124.57 shares 

• Calculate the total shares sold. 

555.09 (shares sold to cover loan) + 124.57 (shares sold to cover taxes) = 
679.67 shares 

• Calculate the new cost basis for the shares. 

[1,000 (total shares) – 679.67 (shares sold)] x $36.03 (FMV) = $11,543 

• Calculate the Gross Sold amount. 

($36.03 x 1,000 shares) – $11,543. = $24,487 

OR 

679.67 shares x $36.03 = $24,487 

The Single Asset Detailed report complements the Stock Option (Gross $) report 
by outlining the future value of the unit price, market value, new cost basis, 
change in units, and other important details. 

4. Go to the Reports menu, and then select Net Worth – Single Asset. 

The Single Asset Document Generator dialog box opens.  

5. Under Asset, select NSO 2004 (Linda). 

6. In the Number of years to project field, enter 7. 

                                                 
6 The fair market value is $36.03 as at Dec 1, 2008: Generate a Single Asset Detailed report for the NSO 2004 and scroll to Dec 1, 2008.
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7. Click Reports, and select Single Asset Detailed. 

8. Scroll through the report to the year 2008. 

Review the details of this report and notice the Sell Amount in December of 2008. 

9. Double-click the Stock Option Analysis Delayed Sale icon to open the Plan 
Analysis window. 

Planning strategy: recommended plan 
With all of the Gellers’ financial objectives illustrated, all we need to do is account for 
the erratic cash flow projected in pre-retirement. The Gellers have decided that they 
should implement a savings strategy for any cash flow that is not being allocated to a 
specific expense or account. You have discussed the idea of redirecting these surplus cash 
flows to a savings plan for retirement, after accounting for a portion of the surplus that 
may not materialize. 

Procedure 
1. Minimize all of the reports. 

2. Right-click the Stock Option Analysis Delayed Sale icon, and then select 
Duplicate. 

3. On the General tab, rename the new plan Recommended Plan. 

4. Go to the Strategies category. 

5. Go to the Surplus Lifestyle Expenses tab. 

6. Click Insert. 

7. To assume a quarter of the projected surplus does not materialize, in the Spend 
What Percentage field, enter 25%. 

8. Leave all of the other fields at the default, and then click OK. 

9. Go to the Savings – Surplus subtab. 

10. To add a surplus savings strategy, click Insert – Strategic Growth Fund 
(Joint/Non-Qualified). 

11. Click Order of Surplus Cash Usage. 

12. The Order of Surplus Cash Usage dialog box opens. Under 1st, select Surplus 
Lifestyle Expenses, and then select Surplus Savings as the 2nd priority. 

This will ensure that in any year a surplus exists, 25% of the surplus will be spent 
out of the plan and the remainder will be redirected to the Strategic Growth Fund. 

13. Click OK. 

14. Click OK, and then click Yes to finish editing the current plan. 

15. Double-click the Recommended Plan folder to open the Plan Analysis window. 
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The results 
By redirecting the surplus cash flow toward an asset, you have achieved a potential 
optimal plan for the Gellers. The Plan Analysis window shows that all cash inflows 
meet cash outflows across the entire planning horizon, and net worth continues to 
grow. How does this compare to the Gellers’ current financial situation? 

1. Within the Plan Analysis window, click the Comparison (scales) button. 

2. The Select a Plan dialog box opens. Select Base Plan (current year), and then 
click OK. 

The two Plan Analysis windows appear side by side. 

The most noticeable change is the pre-retirement cash flow. However, considering 
the financial strategies we have applied in the plan, what effect would you expect 
these strategies to have on the net worth of the plan?  

Compare the net worth of the Recommended Plan to that of the Base Plan. Why is 
the net worth in the Recommended Plan slightly less than that of the Base Plan 
even though the financial strategies that were applied to the plan should have 
helped to increase the net worth? 
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6. Estate planning strategies 

Objectives 
The Gellers were so impressed with the planning illustrations you provided for their 
retirement that they want to discuss their estate in greater detail. Specifically, they are 
wondering what financial strategies are available to ensure the bulk of their estate is not 
eroded by unnecessary taxes. The Gellers have heard that there are a variety of products 
and techniques available to transfer their estate to the appropriate beneficiaries while 
incurring minimal taxes and satisfying their succession planning goals. 

Setting life expectancy for the estate plan 
In the future, the Gellers may want to see some What-if scenarios for the estate situation 
using different life expectancies, but initially they would like to review the 
recommendations assuming the same life expectancies as the rest of the plan. 

To begin the estate plan and set the life expectancies, complete the following procedure. 

Procedure 
1. Right-click the Recommended Plan icon, and then select Duplicate. 

2. On the General tab, rename the new plan Estate Plan. 

3. Go to the Estate Planning category – Planner tab – Existing Estate Plan subtab. 

4. In the Life Expectancy fields, enter age 90 for both Jack and Linda. 

5. Click the magnify glass icon to open the Life Expectancy Scenarios dialog box. 

Here you can set Alternate Life Expectancy dates for the clients. 

6. Ensure that the Reports check box is selected for the Life Expectancy option. 

7. Click OK. 

Planning strategy: A/B scenario, living trust & gifting 
Considering the Gellers’ needs and wishes regarding their estate, you believe that a living 
trust and a commitment to a regular gifting strategy will help them meet some of their 
objectives. The Gellers should also take advantage of the postponement of taxes until the 
death of the second spouse by using a credit shelter trust. By looking at their plan, you 
have determined that they will likely have assets that exceed the applicable exclusion 
upon the first death. Therefore, they could also set up a marital trust to utilize both of 
their applicable exclusions. They could appoint other assets to a marital trust and transfer 
the wealth from their estate at death.  
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Procedure to create the A/B scenario 
We must ensure that assets are available to fund the credit shelter and marital trusts, 
instead of being redeemed to cover deficits. To do this, we must remove the deficit 
coverage records from the assets (the Venture Stock Portfolio and the Income Fund) 
that will fund these trusts. 

1. Go to the Strategies category – Redemptions tab – Deficit Coverage subtab. 

2. Select the Venture Stock Portfolio. 

3. Click the Delete button, and then select Delete Current Selection – Yes. 

4. Select the Income Fund. 

5. Click the Delete button, and then select Delete Current Selection – Yes. 

6. Go to the Estate Planning category – Planner tab – Existing Estate Plan subtab, 
and then click Duplicate to build a new scenario. 

7. In the Estate Planning Scenario Setup dialog box, enter the following 
information: 

Name: AB, Living & Gifting Will Exists: selected 

Gifting: selected Credit Shelter Trust: selected 

Living Trust: selected Other Marital Trusts: selected 

Irrevocable Trusts: selected  

8. Click OK. A new AB, Living & Gifting subtab is created.  

The Credit Shelter Trust dialog box opens. To turn off the automated 
demonstration, go to the Edit menu, and then select the Preferences – System 
tab. Under Demo Options, clear the Show automated demos check box. 

9. Enter the following information on the Trust tab: 

Trust Tax Rate: 40% At death of: 1st to Die 

Funding Amount: clear Autofund Allocation for GSTT Exemption: Fixed 
Amount $0 

Return Rates: 3% Dividends, 3% 
Capital Gains, 2% Deferred 
Growth 

 

Leave all other fields at their defaults. 

10. To ensure that the surviving client receives the income from the trust, click 
Income To. 

11. In the Surviving Client field, enter 100%. 

12. Click OK. 

13. To insert beneficiaries, click Remainder To. 
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14. To add both Sarah and Matthew Geller as remainder beneficiaries of the trust, 
click Add All. 

This will add all of the eligible beneficiaries in the plan as remainder beneficiaries 
of this trust. 

15. To disperse the trust remainder equally between beneficiaries, click Pro-Rata. 

16. Click OK to return to the Credit Shelter Trust dialog box. 

17. Go to the Funding Assets tab. 

18. To add a new funding asset, click Insert, and then select Venture Stock 
Portfolio. 
The Transfer dialog box opens. 

NaviPlan transfers up to the maximum exclusion amount or the amount you 
specify. If an asset is community property, NaviPlan only transfers 50% of the 
asset to the trust. 

NaviPlan allows you to fund multiple trusts with the same asset. However, assets 
that do not support partial transfers (i.e., lifestyle assets) cannot fund multiple 
trusts. If assets are not specified, NaviPlan uses an automatic funding system. 

19. Click OK twice to return to the AB, Living & Gifting subtab. 

20. To add a marital trust to the scenario, click Linda’s Assets after Jack’s death 
and select Edit Other Marital Trusts. 

21. In the Trusts dialog box click Create, and then select Marital Trust. 

22. Enter the following information on the Marital Trust tab: 

Trust Tax Rate: 40% At death of: Jack 

Funding: Asset Transfer Allocation for GSTT Exemption: Fixed 
Amount $0 

Return Rates: 2% Deferred Growth  

Leave all other fields at their defaults. 

23. Go to the Transfers tab. 

24. Click Insert, and then select Income Fund (Jack/Non-Qualified).  

25. The Transfer dialog box opens. The full value of the asset is to be transferred to 
the children. Leave the Transfer % of Market Value field at 100%, and then click 
OK.  

26. To insert beneficiaries, click Remainder To. 

27. Click Add All to insert both Matthew and Sarah as beneficiaries of the trust. 

28. Click Pro-Rata to ensure that the property is transferred equally to both 
beneficiaries. 

29. Click OK three times to return to the AB, Living & Gifting subtab.  
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A value now appears under the Marital trusts for Linda section. 

Procedure to create the living trust 
1. To illustrate a living trust, you must select the Living Trust check box in the 

Estate Planning Scenario Setup dialog box at the beginning of this exercise. All 
assets will be removed from probate automatically. 

To ensure that this is the case, click Jack’s Gross Estate in 2034, and then select 
Edit Asset Estate Details. 

The Asset Estate Details dialog box opens. It is apparent that the Probate check 
box has been cleared for all of the applicable assets. 

2. Click OK to return to the AB, Living & Gifting subtab. 

Procedure to create the gifting strategy 
1. Click Gifts and Bequests, and then select Edit Cash Gifting Strategies. 

2. In the Gifting Strategies dialog box, in the Jack tab, click Insert Regular. 

3. The Regular Gifting dialog box opens. Enter the following information: 

Split Gift: selected  Gifted to: Sarah Geller  

Maximum Annual Exclusion Gift: selected Start Date: Jan – Current Year 

End Date: On death  

4. Click OK. 

5. Click Duplicate, and then click Edit. 

6. Under Gifted to, select Matthew Geller, and then click OK. 

7. Click OK to return to the AB, Living & Gifting subtab. 

The Gifts and Bequests node reflects the value of the gifts. 

8. Go to the Setup tab. 

Assign a growth rate to gifts given to Matthew and Sarah to reflect the fact that 
they will invest these cash gifts.  

9. Go to the Gifting Growth & History tab.  

10. To edit the growth rates for each beneficiary, select the Growth Rate field next to 
the beneficiary, and then click Edit Growth Rate. 

11. Clear the Inflation check box, and then enter 9% as the Growth Rate on Gifts.  

12. Click OK. Complete this process for both Matthew and Sarah. 

13. Enter a tax rate of 25% for both Matthew and Sarah, to approximate an average 
tax rate for both beneficiaries. This will ensure the value of the gifts is reported on 
an after-tax basis. 

14. Go to the Planner tab.  
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The Gifts and Bequests node now reflects the new after-tax growth of the gifts. 

The results 
1. Go to the Summary tab. 

The AB, Living & Gifting scenario is compared with the Existing Estate Plan. 
The Summary tab displays a numerical and graphical representation of total taxes, 
net to heirs, and net to charity. It appears that our scenario has decreased total 
taxes and increased net distributions to heirs. 

2. Click the Reports button, and then select Comparison Report. 

A detailed cash flow comparison illustrates the two scenarios at both Jack’s 
projected deceased date and Linda’s projected deceased date. 

3. Close the Estate Planning Detailed Comparison report. 

4. Go to the AB, Living & Gifting subtab. 

5. Click Reports, and then select Gift Taxes (Jack). 

Since the total gifts exceed the maximum annual exclusion, the unified credit is 
invaded and gift tax is applied. If the gift exceeds the maximum annual exclusion, 
NaviPlan first uses any unified credit before applying gift taxes. The value in the 
Current Interest Gifts to Trusts column signifies Jack’s portion of the premium 
for the life insurance policy that funds the ILIT. 

6. Close the Gift Taxes (Jack) report. 

7. Click OK, and then select Yes to return to the desktop. 

8. Go to the Reports menu, and then select Trusts – Single Trust. 

9. In the Estate Planning Report Settings dialog box, select AB, Living & Gifting, 
and then click OK. 

10. Select Marital Trust, and then click OK. 

The top section of this report provides some basic information on the marital trust. 
The Details section provides a synopsis of the variables. The Summary section 
identifies the amount paid to heirs after the 2nd death. This includes after-tax 
income retained in the trust and any deferred growth. A Funding report lists all of 
the funding assets. The cash flow of the trust is provided for each year after the 
trust is funded, and another report allows you to reconcile the taxes the trust will 
pay. This trust is established in the year the first spouse dies. The assets are 
distributed to the remainder beneficiaries in the year the second spouse dies. 

11. Review the same report based on the credit shelter trust and take note of the 
funding asset for the credit shelter trust. The asset that was used to fund the trust 
is listed along with the Value Transferred, in both a dollar and percentage 
amount. 

12. Minimize all reports on the desktop. 
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Planning strategy: charitable remainder trust  
Jack recently lost his sister to cancer and he would like to leave part of his estate to the 
American Cancer Society. You suggest a charitable remainder trust. This trust allows 
Jack to make a charitable donation, retain an income interest in the property, and obtain 
an income tax deduction in the year of the transfer. 

The Gellers instituted an irrevocable life insurance trust (ILIT) in 2000 that houses an 
insurance policy with a death benefit of $500,000. You tell the Gellers the ILIT can be 
used to develop a strategy of wealth replacement. They are transferring wealth that their 
children could have received to the charity; however they are replacing that wealth for 
their children through the death benefit from the insurance policy. 

This strategy enhances the recommendations of the A/B scenario that you just created. 

Procedure 
1. Go to the Data menu, and then select Estate Planning – Planner. 

2. Go to the AB, Living & Gifting subtab, and then click Duplicate. 

3. In the Estate Planning Scenario Setup dialog box, enter the following 
information: 

Name: AB, Living, Gifting & CRT Charitable Trusts: selected  

4. Go to the Trusts page. 

5. Ensure the AB, Living, Gifting, & CRT scenario is selected. 

6. Select New CRT. 

7. Click Add This Trust. 

The Edit Trusts dialog box opens. 

8. The Charitable Remainder Trust dialog box opens. On the Trust tab, enter the 
following: 

Grantor: Jack IRC 7520 Rate: 3.8%  

Unitrust: selected Optimize: selected 

Frequency: Annual Interest: 4% 

Duration: Joint 2nd to die  

When the Optimize check box is selected, NaviPlan calculates the maximum 
payout to the income beneficiary while ensuring the trust has a 10% remainder 
interest. If the advisor selects a payout rate that leaves less than a 10% remainder, 
a warning message appears. The optimized payout depends on the IRC 7520 rate 
and the trust term entered. You can enter the annual income amount manually if 
the Optimize feature is not used. Income can be paid out monthly or annually. 

Income can be paid to the spouse and/or other heirs. You must click the Payment 
To button and specify the appropriate income recipient. If the grantor wishes to 
retain the income interest, you should ensure that you have not set an income 
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beneficiary in the Beneficiaries dialog box. If no income beneficiary is selected, 
NaviPlan will automatically pay the income to the grantor. This payment can be 
verified in the grantor’s cash flow by using the Cash Flow Assistant and 
reviewing the Investment Income category for the grantor. 

9. Click Payment To, and then enter 100% in the field for Linda. 

10. Click OK. 

11. Click Remainder To. 

12. In the Beneficiaries dialog box, click Insert – American Cancer Society. 

13. Click Pro-Rata to ensure that 100% of the remainder goes to the charity, and then 
click OK. 

14. Go to the Transfers tab. 

15. In the Transfer assets on field, enter the last day of the current month. 

16. Click OK twice to return to the AB, Living, Gifting, and CRT subtab. 

17. Click Recommend.  

When an estate scenario is recommended it will be incorporated with the rest of 
the financial plan. Thus, you will be able to review the effect that the estate 
scenario has on the plan and assess whether this is the best recommendation for 
the client. When a scenario is integrated with the rest of the plan, you will see the 
effects in the Plan Analysis window and in any reports that are generated. 

The results 
1. Go to the Summary tab. 

The AB, Living, Gifting, and CRT scenario is compared to the other two 
scenarios. The Summary tab displays a numerical and graphical representation of 
total taxes, net to heirs, and net to charity. It appears that our scenario has 
decreased total taxes and now displays a value for the net to charity. 

2. Click OK, and then click Yes to finish editing the current plan. 

3. Go to the Reports menu, and then select Trusts – Trust Summary. 

4. Select AB, Living, Gifting & CRT, and then click OK. 

The Trust Summary report shows an overview of the trust activity of all the trusts 
in the scenario. This report allows you to verify the flow of the income of the 
charitable remainder trust to the grantors and to the heads of the family. Also, 
notice the value that appears in the Charitable Deduction column. This deduction 
can be verified in the Income Tax Details report for the grantor. 

5. Go to the Reports menu, and then select Income Tax – Projected Details for – 
Jack.  

6. In the Report Years dialog box, click Quick Pick, select 2004 and 2005, and then 
click OK twice to generate the report. 
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Since this charity is a 50% limited organization, the deductibility is limited to 
50% of the adjusted gross income. The adjusted gross income reveals that Jack 
has sufficient income to allow the entire deduction in the current year (year of 
transfer). Any amount over this value will be carried forward for five years. 

7. Go to the Reports menu, and then select Estate Planning – Gift Taxes (Jack). 

8. Select AB, Living, Gifting, and CRT, and then click OK. 

The total gift amount of $7,500 has been split. Since this is a joint life insurance 
policy, the annual amount is shared between Jack and Linda. Also, the 
combination of gifting to their children and paying the life insurance premiums 
has exceeded the annual gift exclusion. Consequently, we can see gift taxes 
calculated and the applicable credit applied. 

9. Minimize all reports on the desktop. 

Planning strategy: family limited partnership and grantor 
retained trust 
Jack owns a small business, which will be taken over by his son when Jack retires. There 
is some uncertainty about whether or not Jack’s son will be able to run the business 
effectively. Jack would rather sell the business than watch mismanagement ruin it. Jack’s 
son is in his last year of college and is starting to look seriously at his future. Jack was 
wondering how a family limited partnership would allow him to gift his interests to his 
son over time, yet still give Jack a say in the business. 

Jack also plans to become involved in the S corporation that his friend has presented to 
him. He has no plans to sell his interest in this business during his retirement as the 
income projections state that he may begin to receive distributions from the business after 
time. He would, however, like to transfer this ownership later on in life so that his family 
can benefit from this endeavor. He is committed to capital contributions for 10 years after 
the initial purchase, but would consider a transfer after this time. There are various 
entities that could be used to illustrate this transfer of wealth including a grantor retained 
trust. This type of entity will allow Jack to benefit from the business until his death, while 
allowing the business to be transferred later. 

Because of Jack’s uncertainty surrounding the transfers of these businesses, it may be 
beneficial to model the family limited partnership and the grantor retained trust as a 
separate estate-planning scenario. If the Gellers decide that this is the appropriate way to 
transfer these properties, you can incorporate these strategies into the recommended 
estate scenario at a later date. 

Procedure 
1. Go to the Data menu, and then select Estate Planning – Planner. 

2. Go to the Existing Estate Plan subtab, and then click Duplicate. 

3. In the Estate Planning Scenario Setup dialog box, enter the following 
information: 
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Name: FLP and GRT Wills Exists: selected  

Irrevocable Trusts: selected Family Limited Partnerships: selected 

4. Click OK. A new FLP and GRT subtab is created. 

5. Click FLPs and Irrevocable Trusts, and then select Edit Trusts. 

6. Click Create, and then select Family Limited Partnership. 

7. In the Select Asset to Transfer to Trust dialog box, select Commercial Properties 
LLC, and then click OK. 

8. In the Family Limited Partnership dialog box, on the General tab, enter the 
following: 

Name: Geller FLP  

Marketability Discount Rate: 15% Minority Interest Discount Rate: 20%  

Deferred Growth: 3%  

9. Go to the Transfers tab, and then in the Transfer assets on field, enter Dec 31 
2008. 

10. Go to the Partners tab, and then insert Jack and Matthew Geller as partners. 

Jack is designated as a general and limited partner automatically. Matthew is 
designated as a limited partner automatically. Initial ownership of limited interests 
is based on the ownership of the assets transferred to the trust. Matthew begins 
with a zero ownership interest. 

11. Go to the Income Distributions tab. 

Transfer of the ownership interest to Matthew is accomplished by entering FLP 
gifting strategies. If the client holds an existing FLP where some transfer of 
ownership has already been gifted, this would be entered on the Setup – Funded 
Trusts tab. 

12. Click Insert, and then select Periodic. 

The payout to each partner is based on ownership interest. It is taxed in the hands 
of the partners. 

The amount will be $120,000 per year starting January 1, 2009. Under Increase 
amount after start date by, select Inflation Rate, and then click OK. 

These distributions occur until the second spouse dies. At that point, any FLP 
interests that have not been gifted and remain in the name of the last surviving 
spouse will be distributed and taxed with the estate. 

13. Go to the Gifting tab, and then click Insert – Periodic. 

14. In the Gift Ownership dialog box, enter the following information: 
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Gifted by: Jack (Limited Partner) Gifted to: Matthew Geller (Limited Partner)  

Maximum Annual Exclusion Gift: selected Start Date: Jan 1, 2009 

15. Click OK twice to return to the Trusts dialog box. Now create the grantor 
retained trust for the transfer of the S corporation that Jack owns. 

16. Click Create, and then select Grantor Retained Trust. 

17. In the Select Asset to Transfer to Trust dialog box, select S-Corp venture, and 
then click OK. 

18. In the Grantor Retained Trust dialog box, on the Trust tab, enter the following: 

Grantor: Jack IRC 7520 Rate: 3.8% 

Unitrust: selected Frequency: Annual 

In Kind: selected Transfer to: Create new asset 

Duration: Term Certain Term: 15 

Deferred Growth: 4%  

Leave all other fields at their defaults. 

19. Go to the Transfers tab. 

20. Jack will maintain control of the S corporation outside of the trust until his 10 
years of capital contributions have been satisfied. In the Transfer assets on field, 
enter Dec 31, 2018. 

21. Jack would prefer to leave the business to Matthew and then equal out the estate 
for Sarah using other assets, as Matthew is more business-oriented. Click 
Remainder To. 

22. Click Insert, and then select Matthew Geller. 

23. Click Pro-Rata to allocate all of the remainder to Matthew. 

24. Click OK three times to get back to the FLP and GRT subtab. 

The results 
1. Go to the Assets category – Detailed tab. 

A new asset appears titled Transfer from Grantor Retained Trust.  

2. Double-click the Transfer from Grantor Retained Trust asset to open the Asset 
Details dialog box. 

This asset was created due to the In Kind selection for the grantor retained trust. 
Where trust income is insufficient to cover income distribution from a grantor 
retained trust, trust assets need to be liquidated and distributed. This liquidation 
could trigger capital gains, which would be taxed to the grantor. The Transfer 
from Grantor Retained Trust asset is a non-qualified asset and is fully editable. 
Asset classes, market values, buys, and sells can all be adjusted to reflect the true 
in-kind transfer situation. 
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3. Click OK twice, and then click Yes to return to the desktop. 

4. Go to the Reports menu, and then select Trusts – Single Trust. 

5. Select FLP and GRT, and then click OK. 

6. In the Select Trust dialog box, select Grantor Retained Trust, and then click 
OK. 
Review the Cash Flow section of the report. The note at the bottom of this section 
states that Distributions may include In-kind distributions of assets from the trust.  

The Remainder Interest is listed as the present value of the remainder interest at 
the date when the transfer occurred (2018). The Remainder to Heirs is the value 
of the trust assets when they pass to the beneficiaries at Jack’s death. The Amount 
in Gross Estate is the value of the trust assets that are included in his gross estate. 

7. Go to the Reports menu, and then select Trusts – Single Trust. 

8. Select FLP and GRT, and then click OK. 

9. In the Select Trust dialog box, select Family Limited Partnership, and then click 
OK. 
The Ownership Summary (End of the Year) section demonstrates how the 
ownership interest gradually transfers to Jack’s son. 

10. Go to the Reports menu, and then select Estate Planning – Payments to 
Beneficiaries Scenarios Comparison. 

11. Select the FLP and GRT estate scenario, and then click OK. 

The Transfer to Linda section of the report shows the transfer to her at Jack’s 
death (first to die). 

12. Minimize all of the reports. 
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7. Monte Carlo Sensitivity Analysis 
NaviPlan’s Monte Carlo Sensitivity Analysis tests the likelihood of success by randomizing 
return rates and life expectancy. It is best to perform the Monte Carlo Sensitivity Analysis on 
the plan that you will recommend to the client. 

Standard deviation can be calculated in a variety of ways. You can allow NaviPlan to 
estimate the standard deviation for each asset based on their return rates by using a look-up 
table you create. Using the look-up table, you can define a standard deviation for each asset 
entered. Or, you can define standard deviations for each asset class, and then allow the asset 
class weightings of each asset to define their standard deviation. Refer to the chapter titled, 
Monte Carlo Sensitivity Analysis in the Theory Behind NaviPlan Extended guide for 
additional information. 

Procedure 
1. Select the Estate Plan icon. 

2. Go to the Graphs menu, and then select Monte Carlo. 

3. In the Monte Carlo Sensitivity Analysis Settings dialog box, enter the following 
information: 

Annual Cash Flow Deficit Tolerance: -$20,000 Randomize Life Expectancy: selected 

Education Goals Tolerance: $0 Major Purchase Goals Tolerance: -$500 

Show Goal Details Graphs In Report: 
selected 

Number of projection to start with: 200 

Use the standard deviations that were calculated using the asset classes method. 

Leave all other fields at their defaults. 

4. Click OK. 

The time required to perform an analysis varies based on the speed of your 
computer’s processor. As the number of projections increases, so does the time 
required to perform the calculations. The estimated time remaining is displayed next 
to the Number of projections to start with field. 
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8. Document packages 

Creating new document packages 
If the default document packages in NaviPlan do not meet your reporting needs, you can 
create your own document package containing only the reports, graphs, and concepts that 
you choose along with your own customized text. 

Procedure: create new document package icon 
1. Select the Base Plan icon. 

2. Move all of the other plans on the desktop into the filing cabinet. 

3. Generate and minimize the following reports and graphs: 

• Current Year Cash Flow Summary  

Reports – Cash Flow – Current Year Summary 

• Plan Analysis Synopsis  

Reports – Synopsis 

• Total Income and Total Tax 

Graphs – Cash Flow – Total Income & Taxes; Ending Year 2010 

Click OK. 

• Net Wealth Accumulation 

Graphs – Net Worth – Net Wealth Accumulation; Ending Year First to 
Retire 
Click OK. 

4. Delete any other reports or graphs that appear on the desktop, except for the ones 
created in the previous step. 

5. Go to the File menu, and then select New – Document Package. 

6. In the Save Document Package as dialog box, name the file Specialized Client 
Report, and then title it Specialized Client Report. 

7. Click OK. 

The Specialized Client Report dialog box opens, and contains all the reports and 
graphs you just created. 

Procedure: create labels 
1. Click Edit Labels. 

2. In the Labels dialog box, change the label from Base Plan to Current Plan. 

3. Click the Actual Item column for the Current Plan label, and then select Base 
Plan (current year). 
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4. Click OK. 

Procedure: create document template 
1. Click Client Report, and then select Create. 

2. In the Create New Template dialog box, name the file Specialized Client Report, 
and then click OK. 

The template file name appears next to the Client Report button. 

3. Click Client Report, and then select Edit. 

Your word processing application opens automatically. 

Procedure: modify tags in document template 
To enhance the appearance of the client report, move the Plan Analysis Synopsis 
report to the very end as an appendix, and then order the other reports and graphs as 
you want them to appear. You can also add customized text to the document. 

1. Locate the Plan Analysis Synopsis heading. 

2. Cut the Plan Analysis Synopsis heading and its associated tags from their current 
position. 

3. Proceed to the end of the template, and then insert a Page Break after the last set 
of tags. 

4. After the page break, enter Appendix as a heading. 

5. Enter two hard returns. 

6. Paste the Plan Analysis Synopsis and its related tags underneath the new 
heading. 

7. Locate the Net Wealth Accumulation heading. 

8. Enter two hard returns and add the following text above the Net Wealth 
Accumulation graph: 

<Mr. and Mrs. Geller>, this graph illustrates the growth in your total assets from 
now until your retirement in <year of retirement>. At the end of <current year> 
your total net worth will be <$> and it will grow to <$> by your retirement. 

9. Use the table at the end of this chapter to insert the appropriate tags in place of the 
bold text. 

10. When you have finished editing the file, go to the File menu, and then select 
Save.  

11. Go to the File menu, and then select Exit. 

12. Click Create Client Report. 

A message asks if you would like to freeze the plan date. Do not freeze the plan 
date if you want to update the report data to the current date the next time you run 
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this client report. Freeze the plan date only if you want the same results each time 
you run this client report. 

13. Click No. 

14. The Specialized Client Report opens. 

Verify that the tags you inserted and corresponding information are correct. 

Review the tag if an error message opens to alert you that a tag is not recognized. 
Any extra spaces or omissions will cause the tag to be unrecognizable. Another 
possible error may be that the label has not been properly defined. 

Editing existing document packages 
If the default document packages in NaviPlan do not meet your reporting needs, you can 
modify them to better reflect your own requirements. 

The original NaviPlan document packages and templates are read-only files and cannot 
be modified in their existing state. This is a safeguard to ensure that the original 
document packages are saved for your future use. If you want to modify one of the 
original document packages, you must first save the package under a new name. This 
removes the read-only attribute and the new package then becomes fully editable. 

Procedure: remove read-only attribute 
1. Select the Preliminary Analysis icon. 

2. Go to the File menu, and then select Save – Document Package As. 

3. In the Save Document Package as dialog box, name the file Custom Client 
Report, and then title it Custom Client Report. 

The NaviPlan document package (NDP) defines and stores all of the reports, 
graphs, and concepts that will be used to generate the final report. All document 
packages are saved with an .ndp file extension. 

4. Click OK. 

Procedure: add reports, graphs, or concepts to the .ndp file 
To add reports, graphs, and concepts to the document package, you must first 
generate them. 

1. Move all of the existing reports to the Trash. 

2. Select the Base Plan icon. 

3. Go to the Reports menu, and then select Cash Flow – Retirement Income 
Summary. 

4. In the Projection Criteria dialog box, enter 2007 in the Ending Year field, and 
then click OK. 

5. Minimize the Retirement Income Summary report. 

6. Go to the Graphs menu, and then select Cash Flow – Total Income & Taxes. 
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7. In the Projection Criteria dialog box, enter 2007 in the Ending Year field, and 
then click OK. 

8. Minimize the Total Income and Total Tax graph. 

9. Drag the Retirement Income Summary icon and the Total Income and Total 
Tax icon onto the Custom Client Report icon. 

10. Double-click the Custom Client Report icon. 

The report and graph appear at the bottom of the list. 

Procedure: edit labels 
Labels allow you to keep the document package generic. This lets you use a 
document package for multiple client files. The label for each item in the document 
package relates to a specific plan in the client file. NaviPlan draws the information for 
the report from the plan that is selected as the Actual Item. Before tags are created, 
you must edit the labels and select the Actual Item for the report or graph. 

1. Click Edit Labels. 

2. In the Labels dialog box, select Base Plan, and then click Delete. 

3. Click Yes to delete the plan label. 

4. Click the Actual Item column for the Current Plan label, and then select Base 
Plan (current year). 

5. Click OK. 

Procedure: add tags to the .ndt file 
The NaviPlan document template (NDT) contains all the text that appears in the final 
client report. The order, layout, and appearance of the client reports are all defined in 
the NDT file using tags that are inserted into the template. A tag extracts data from 
the NaviPlan client file and includes that data in the final client report. Tags are not 
automatically inserted into the template by dropping a report or graph onto the 
document package. You must still add tags to the template file.  

Document templates are saved with an .ndt extension. 

1. Select Retirement Income Summary and Total Income and Total Tax. 

2. Click Copy as Tag. 

3. Click Client Report, and then select Edit.  

Your word processing application opens automatically. 

4. Within your word processing application, scroll down to the Retirement Goals 
heading. 

5. Enter a hard return under the Retirement Goals heading, and then paste the tags 
for the Retirement Income Summary report and the Total Income and Total Tax 
graph. 

6. The following tags should appear: 
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<Retirement Income Summary; Plan = Current Plan> 

<Total Income and Total Tax; Plan = Current Plan> 

7. Above the Total Income and Total Tax graph tag, enter the following text: 

America’s inflation rate has changed during the last 3 decades from a high of 
13.3% in 1979 to the current rate, which is below 2.0%. We have used 
<Current Plan; Inflation Rate> for all projections. 

8. Go to the File menu, and then select Save As. 

9. In the Save As dialog box, in the File Name field, enter Custom Client Report, 
and then click Save. 

10. Go to the File menu within your word processing application, and then select 
Exit. 

Procedure: link new document template to document package 
1. Click Client Report, and then select Select. 

2. In the Select Template dialog box, under File Type, select Rich Text Files 
(*.RTF). 

3. Select Custom Client Report.rtf, and then click OK. 

The Custom Client Report.rtf file name now appears beside the Client Report 
button. 

4. Click Create Client Report to generate the Custom Client Report. 

A message asks if you would like to freeze the plan date. Do not freeze the plan 
date if you want to update the report data to the current date each time you run 
this client report. Freeze the plan date only if you want the same results each time 
you run this client report. 

5. Click No. 

6. In the Select Document Sections dialog box, choose the sections to include in the 
report, and then click OK. 

The Custom Client Report opens. 

Verify that the tags you inserted and corresponding information are correct. 
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Tags table 
The tables below are to be used as reference for the more common tags that you may 
need to use when creating and editing document packages. For a more complete list 
of applicable tags, use the Help feature in NaviPlan. 

Head tags  

<HeadnTitle> The title to use in reference to head n (Mr., Ms., Dr., 
etc.). 

<HeadnGivenName> The given name of head n (Bob, Jane, etc.). 

<HeadnSurname> The family name of head n (Smith, Murphy, etc.). 

<HeadnFullName> The full name of head n, which consists of the 
person’s given name and surname (e.g., Bob Smith). 

<HeadnFormalName> 

<HeadFormalNames> 

The formal name of head n consists of the person's 
title and surname (e.g., Mr. Smith). 

<HeadnBirthDate> The date of head n’s birth (May 24,1957). 

<HeadnAge> The age of head n as of today’s date. 

<HeadnPlanAge> The age of head n at end of the active plan’s year. 

<HeadnSSN> The Social Security number of head n (e.g., 
123456789). 

<HeadnGender> The gender of head n (Male or Female). 

<HeadnFunction> The function of head n (Husband, Wife, Single 
Parent). 

<HeadnAddressType> Head n’s address type (Home, Business). 

<HeadnStreet> Head n’s street. 

<HeadnStreet2> Head n’s street. 

<HeadnCity> Head n’s city. 

<HeadnState> Head n’s state of residence. 

<HeadnCountry> Head n’s country. 

<HeadnZipCode> Head n’s zip code. 

<HeadnHomePhone> Head n’s home phone number. 

<HeadnFaxPhone> Head n’s fax phone number. 
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<HeadnBusinessPhone> Head n’s business phone number. 

<HeadnRetireDate> Head n’s retirement date. 

<FirstHeadRetireYear> . The year the client or co-client retires, whichever is 
earliest. 

<HeadnRetireAge> Head n’s retirement age. 

Plan tags 

<Plan> The plan window, complete with the status bars and 
both graphs. 

<PlanName> The plan’s name. 

<PlanYear> The plan’s year. 

<PlanAnalysisStr> The analysis of the plan window’s graphs. 

<PlanDescription> The description associated with the plan. 

<CashFlowAnalysisStr> A summary (in table form) of the client’s cash flow 
over the next 5 years. 

Informational tags 

<I-Total Net Worth; Plan=Current Plan; 
Year=Current Year> 

Total Net Worth at the end of the current 
year 

<I-Total Net Worth; Plan=Current Plan; 
Year=First Retire Year>  

Total Net Worth upon retirement 

<I-IRA Net Contributions; Plan=Current 
Plan; Year=Current Year; Member=Head 
1> 

Current Year IRA contribution for client 1 

<I-Pension Net Contributions; 
Plan=Current Plan; Year=Current Year; 
Member=Head1> 

Current Year Pension contribution for 
Head 1 

<I-IRA Net Contributions; Plan=Current 
Plan; Year=Current Year> 

Total IRA contributions for the current 
year  
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Customized text for Specialized Client Report 
<HeadFormalNames>, this graph illustrates the growth in your total assets from now 
until your retirement in <FirstHeadRetireYear>. At the end of <PlanYear> your total 
net worth will be <I-Total Net Worth; Plan=Current Plan; Year=Current Year> and it 
will grow to <I-Total Net Worth; Plan=Current Plan; Year=First Retire Year> by 
your retirement. 
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